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AlarmBook™ 1.3 Order form

Price: $30 U.S. dollars

Name: __________________________

Address: __________________________
__________________________

__________________________
__________________________

Phone: (optional) __________________________

Date Mailed: __________________________

Signature:__________________________

Mail To: Neptune Systems
12803 Rampart
Austin, Texas 78727-3249

For information on receiving a customized version of AlarmBook™ for
your specific needs, call Neptune Systems at 1-800-566-1247.

Chapter 1 Introduction and Features   1



Chapter 1 Introduction and Features   2

AlarmBook™
User Manual

for Apple® Macintosh® Computers

Neptune Systems
12803 Rampart

Austin, Texas 78727
(512) 837-1247
1-800-566-1247
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Copyright © 1993  Neptune Systems.  All Rights Reserved.
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NOTICES 

TRADEMARKS

AlarmBook™ is a trademark of Neptune Systems.  All other brands or product names are trademarks or
registered trademarks of their respective holders.

COPYRIGHTS

The AlarmBook™ software and manual are Copyright © 1993 Neptune Systems.  All rights reserved.  No
part of this manual may be reproduced, stored in a retrieval system, or transmitted, in any form or by any
means, electronic, mechanical, photocopying, or otherwise, without prior written permission of Neptune
Systems.  Printed in the United States of America.

Chapter 1 Introduction and Features   4



Chapter 1 Introduction and Features   5

TABLE OF CONTENTS
_____________________________________________________________________________

Chapter 1: INTRODUCTION AND FEATURES 1

Chapter 2: SYSTEM REQUIREMENTS 3

Chapter 3: INSTALLATION 4

Chapter 4: SETTING UP A DATE SPECIFIC ALARM 5

Chapter 5: SETTING UP A PERIODIC ALARM 7

Chapter 6: SETTING UP A CHIME ALARM 9

Chapter 7: RESETTING AND REMOVING ALARMS 10

Chapter 8: RECORDING PERSONAL MESSAGES 11

Chapter 9: LOADING AND SAVING ALARM COLLECTIONS 16

Chapter 10: ACTIVATING THE ALARM COLLECTION 17

Chapter 11: USING ALARMBOOK DISC FILES 18

Chapter 12: CONFIGURING ALARMS TO PERFORM TASKS 19

Chapter 13: USING AUDIONOTES 20

Chapter 14: SENDING MESSAGES OVER THE NETWORK 22

Chapter 15: SENDING FILES OVER THE NETWORK 24

Chapter 16: CHANGING APPLETALK ZONES 25

Chapter 17: PREFERENCES 26

Appendix of COMMON ERRORS 27

License and Limited Warranty Agreement 30

Chapter 1 Introduction and Features   5



Chapter 1 Introduction and Features   6

Neptune Systems would like to take this opportunity to thank you or your organization for purchasing AlarmBook.
Our original intentions were to develop a software product that would allow a Macintosh user to record and play
audio reminders in such a way as to aid in daily organization and personal performance. 

AlarmBook has many useful features. You can use AlarmBook to create up to 30 custom alarms that play audio
and/or visual messages at periodic intervals. These alarms can be used to program or condition yourself to learn
new beneficial habits. Or, they can simply remind you of the tasks you need to perform every day.

You can also use AlarmBook to create up to 30 custom alarms that play audio and/or visual reminders at specific
date and times. These alarms will remind you of appointments months from now, or just keep you organized from
week to week.

If  your  Macintosh  is  connected  to  an  Appletalk  network,  you  can  use  AlarmBook  to  send  audio  and  visual
messages to any legitimate AlarmBook user. Once a message is sent, the destination user's Macintosh sends a
response message within 15 seconds. 

You  will  be  notified  of  incoming  messages  immediately,  regardless  of  the  application  you  may  be  running.
AlarmBook also allows you to send files to other AlarmBook users on your local network. There is no need to log
on to another user's Macintosh to retrieve or send files. Files can be transferred quickly and effortlessly!

AlarmBook can also be used as an alarm clock on Macintosh portables with sleep capabilities.  Simply configure
the  alarm  and  put  your  Macintosh  into  sleep  mode.  AlarmBook  will  program  your  Macintosh  to  awaken
approximately 15 seconds before the alarm goes off. For portables with no manual power switch, AlarmBook will
cause your Macintosh to turn on just before an alarm is ready to go off.

The AudioNote application allows you to record into itself.  It can be used to keep a personal collection of audio
reminders. The volume, size, and quality of the recording are determined by the control settings you pick when
creating the AudioNote. Since the audio sample is contained within AudioNote application, there is no need to
access a separate file to hear your sound. Simply click twice on the AudioNote to listen to your message. The
AudioNote can be used on any Macintosh with recording capabilities.

Another useful feature is the ability of AlarmBook to perform a launch (execute an application) or power off task
when an alarm goes off. For example, if you need to start up an application at a specific time of day to back up
your hard disk, just select launch and choose the backup program you wish to execute. If you are worried about
accidentally leaving your Macintosh on overnight, just set up an alarm to power off your Macintosh at the end of
the day. The launch task is only available when using System 7.0 or later.
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The more you use AlarmBook, the more you will discover its useful and interesting applications. Listed below are a
few examples of things you can do with AlarmBook.

• Help students create self tests for schoolwork.

• Help condition yourself to form better habits.

• Give audio/visual reminders of important appointments.

• Send audio and visual messages to AlarmBook users on your Appletalk network

• Train yourself in a new foreign language.

• Record AudioNotes and give them to a business partner or friend. 

• Keep a log of events in your life using AudioNotes.

• Keep a personal audio diary that has the advantage of emotion and tone.

• Use your PowerBook with AlarmBook instead of a wake up call when traveling.

• Train your pet bird to talk.

• Execute applications at a particular time of day to control laboratory experiments.

• Program your Macintosh to power off at the same time every day.

We hope you find many useful applications of this software product. Neptune Systems' intentions are to help the
personal Macintosh users, as well as the business users, better themselves. Thank you for helping contribute to
the future development of our new software products.

Please take the time to fill out and mail your product registration card.  Doing so will authorize Neptune Systems
technical  support  to help you with any problems you may encounter.   As a registered customer of  Neptune
Systems, you will receive information concerning updates on future product revisions.
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AlarmBook requires minimum System 6.0.7 running Multifinder. AlarmBook supports all Macintosh Plus or later
models with a minimum 2MB RAM. AlarmBook is also compatible with virtual memory and 32bit operation modes.
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To make a backup copy of your original distribution disk, use a disk copy utility which copies the entire disk in its
original format.

This  software  package  consists  of  one  800k
distribution disk, the AlarmBook user manual, and a
product registration card.

Insert the distribution disk into your disk drive and
wait  for  the  disk  contents  window  to  appear.  The
items will appear as shown in the figure to the right.
Using  the  mouse,  click  twice  on  AlarmBook™
Installer. 

The dialog box illustrated to the right is  the initial
screen of the AlarmBook installation program.

If  you  have  previously  installed  AlarmBook,  the
installer will replace the outdated AlarmBook files. 

Now, register a name for your Macintosh and press
return.  Your registered name will appear in the initial
title screen of the AlarmBook™ application.

Once installed, the AlarmBook™ application must be
run from the original drive it was installed on.

After the installation is successfully completed, follow
the installer directions and restart your Macintosh. If
no  errors  occurred,  you should  see  the  AlarmBook
icon  displayed  in  the  lower  left-hand  corner  after
restarting.  This  indicates  that  the  AlarmBook™ Init
file has successfully loaded.

You  will  now  have  a  new  folder  named
AlarmBook™ Folder  in  the  root  directory  of
your startup disk. This folder will contain the items as
shown in the figure to the right.

To execute the AlarmBook application quickly when
using System 7.0 or later, simply choose "AlarmBook
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Desk" from the Apple menu.  In systems prior to 7.0,
the  desk  accessory  is  used  exclusively  by  the
AlarmBook INIT file.

Chapter 1 Introduction and Features   10



Chapter 1 Introduction and Features   11

AlarmBook contains enough space to hold 30 separate alarms. An alarm can be a date specific alarm, periodic
alarm, or chime alarm. For each alarm, you can define your own unique settings.

The first step in creating a date specific alarm is to
select the  File menu in the menu bar and choose
New date alarm.

     

A window will appear requesting that you enter the
name  of  the  new  alarm.  Enter  any  alphanumeric
name  you  wish  and  press  return.  Once  you  have
named the alarm, a new window will appear showing
the alarm's default settings.

     

To set the alarm date and time, adjust the scroll bars
labeled  Hour,  Minute,  Month,  Day,  Year.
Then, check the AM or PM button. 

     

To verify the current date and time, click the button
labeled Set Time to automatically assign the date
and time values to the appropriate scroll bars.

                  

Chapter 1 Introduction and Features   11



Chapter 1 Introduction and Features   12

If  you wish to have a visual  message, simply type
your  message in  the text  entry  box located in the
upper half of the window.

To choose a sound for  your alarm,  simply select  it
using  the  audio  selection  box in  the  center  of  the
window.

Use the Playback Volume scroll bar to select the
volume level of your alarm's audio message.                 

To  make  the  alarm occur  on  a  daily  basis,  simply
check the button labeled  Daily Alarm.  The day
and month settings are irrelevant when configuring
an alarm to be a daily alarm.

The alarm is now configured. If you wish to edit an existing alarm, simply select it using the Alarms menu.  A
window will appear showing all of the alarm's current settings.  You may edit any of these settings, or delete the
alarm if you choose.

You are not required to have a visual or an audio message in conjunction with your alarm. It is your choice as to
which one of these options to select. If you choose not to have a visual message, simply leave the text entry box
empty (this includes spaces).

Chapter 1 Introduction and Features   12



Chapter 1 Introduction and Features   13

To  make  the  alarm active  (the  alarm will  be  alive
when you activate the alarm collection as described
in  Chapter  10)  simply  click  on  the  button  labeled
Active.
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Setting up an periodic alarm is similar to setting up a date specific alarm. You can choose to have an audio and/or
visual alarm occur at periodic intervals. Instead of choosing a specific date and time, simply specify the time
interval and the number of repetitions of the alarm in that interval.

The first step in creating a periodic alarm is to select
the  File menu in the menu bar and choose New
periodic alarm.

     

A window will appear requesting that you enter the
name  of  the  new  alarm.  Enter  any  alphanumeric
name  you  wish  and  press  return.  Once  you  have
named the alarm, a new window will appear showing
the alarm's default settings.

To set the interval in which the repetitions will occur,
adjust  the  scroll  bars  labeled  Minutes and
Hours.      

To set the number of repetitions within that interval,
adjust the scroll bar  Repetitions. For example, if
you want to play an audio message once every ten
minutes,  adjust  the  Repetitions to  1,  the
Minutes to 10, and the  Hours to 0. Similarly, if
you want to play an audio message 5 times every 8
hour  day,  adjust  the  Repetitions to  5,  the
Hours to 8, and the Minutes to zero.
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If  you wish to have a visual  message, simply type
your  message in  the text  entry  box located in the
upper half of the window.

To choose a sound for  your alarm,  simply select  it
using  the  audio  selection  box in  the  center  of  the
window.

Use the Playback Volume scroll bar to select the
volume level of your alarm's audio message.                 

To  make  the  alarm active  (the  alarm will  be  alive
when you activate the alarm collection as described
in  Chapter  10)  simply  click  on  the  button  labeled
Active.
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A chime alarm is a unique alarm that will play a user specified audio every hour similar to the way a grandfather
clock chimes every hour. The audio we intended for the chime is called GRANDFATHER CLOCK.  It is one of the
audio sounds supplied by this software package. You are not required to use the GRANDFATHER CLOCK audio
for your chime alarm. You can use any audio you wish, including your own personal message.

The first step in creating a chime alarm is to select
the  File menu in the menu bar and choose New
chime alarm.

     

A window will appear requesting that you enter the
name  of  the  new  alarm.  Enter  any  alphanumeric
name  you  wish  and  press  return.  Once  you  have
named the alarm, a new window will appear showing
the alarm's default settings.

To  choose  a  sound  for  your  chime  alarm,  simply
select it using the audio selection box in the center of
the window.

If  you wish to have a visual  message, simply type
your  message in  the text  entry  box located in the
upper half of the window. At the start of every hour,
your visual message will be displayed first, followed
by your audio next.
Use the  Chime Volume scroll  bar to select the
playback  volume  level  of  your  chime's  audio
message.                     

To make the chime alarm active (the alarm will  be
alive  when  you  activate  the  alarm  collection  as
described in Chapter 10) simply click on the button
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labeled Active.
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To reset an alarm back to it's default settings, select the alarm using the Alarms menu, then choose the Reset
this alarm option in the Options menu.

To reset all alarms back to their default settings, choose the Reset all alarms option in the Options menu.

To delete an individual alarm, select the alarm using the Alarms menu, then choose the Delete this alarm
option in the Options menu.

To delete all alarms, choose the Delete all alarms option in the Options menu.
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If you own a Macintosh with recording capabilities and are running System 7.0 or later, AlarmBook will allow you
to record your own personal message for use as an alarm sound. Simply go to the control panel and choose
Sound. A small window will appear that shows you which, if any, microphone ports are registered with the
operating system. Choose a microphone by clicking on the microphone icon in the lower portion of the window.
This is the input device AlarmBook will use when recording.
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To start the recording process, select the  Options
menu in the menu bar and choose Record audio
sample.

A window will appear containing the controls needed
to specify your recording options.

Now, select the maximum amount of time you wish
to record by adjusting the Recording Limit scroll
bar.                 

As you adjust the Recording Limit scroll bar, the
memory  used  value  is  updated.  This  is  the  total
amount of memory needed if your recording uses all
of the maximum requested time. Normally, you won't
use as much time as you originally request.

                      

Because of memory limitations, AlarmBook provides three different compression modes for sound recording. The
quality of your recording is directly related to which compression mode you choose. If you desire the highest
recording quality, adjust the Recording Quality scroll bar to Excellent (no compression).
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If you wish to record using a moderate quality, adjust the  Recording Quality scroll bar to  Good (3 to 1
compression).

For a fair quality, adjust the Recording Quality scroll bar to Fair (6 to 1 compression).

Notice that the memory required changes dramatically as you reduce the quality of your recording. You can use
the memory indicator to determine how much memory your recording will require.
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When you are ready to record, click on the Record
button. If you do not have enough memory available
to  make  the  recording,  a  warning  dialog  box  will
appear  requesting  that  you  reduce  the  recording
time, change the recording quality,  or increase the
memory size of the AlarmBook application.

                  

To increase the memory size of AlarmBook, you must
first quit the AlarmBook application.  Next, select the
AlarmBook  icon  by  clicking  once  on  it.  Use  the
Command-I key sequence or the Get Info option in
the  standard  apple  file  menu  to  bring  up  the
application's  information  window.  Type  in  a  larger
Current Size and close the window. Now run the
AlarmBook application again and try to record your
audio sample.

Once  you  see  the  standard  recording  dialog,  click
Record to start recording. When you are finished,
click Save to continue. You will then be prompted to
type in the name of the new sound. Type in a name
and press return to exit the recording procedure. Your
new sound will  be appended to  the  Audio menu
and also to your resident audio area.
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If you wish to delete an audio sample, simply choose
the  Delete option in the  Audio menu and select
the audio sample you wish to delete.

If you wish to play an audio sample, simply choose
the Play option in the Audio menu and select the
audio sample you wish to play.  The audio sample is
played  at  the  volume  level  as  configured  in  the
sound control panel utility.
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The 30 alarm items contained in AlarmBook constitute an alarm collection. An AlarmBook collection file type is
identified by the sphere icon. An alarm collection consists of all resident sounds, visual messages, task details,
and configurations particular to the 30 configured alarms within the Alarms menu. You can save this particular
collection of alarms for loading at a later time by selecting the Save alarm collection option in the Options
menu.

When you wish to load an alarm collection,  simply
select the Load alarm collection option. 

    

A standard file selection dialog box will prompt you to
identify  the  alarm  collection  file.  Only  AlarmBook
type collection files will appear in the file list. Once
you have chosen the file, click  Load to proceed or
Cancel to abort.

The  alarm  collection  will  then  be  loaded  and  the
audio portion will  be copied to your resident audio
area.

Alarm  collections  can  also  be  loaded  by  simply
clicking  on  them  while  outside  the  AlarmBook
application.
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AlarmBook automatically activates all date, chime, and periodic alarms that are checked as Active when exiting
the AlarmBook application.  Your alarm collection is also activated when your Macintosh is restarted or powered
on.
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All  sounds and audio messages that appear  within
the Audio menu are stored in the AlarmBook™ Init
file in your system folder. If you wish to delete this
resident audio, select the  Delete resident audio
option within the Options menu. If you wish to load
audio  from a  disc  file  or  an  AudioNote,  select  the
Load  note/disc  audio option  in  the  Options
menu. 

AlarmBook also allows you to load a sound from a
standard  'sfil'  type  file.  These  files  are  created  in
System 7 by moving a sound out of the system file.

    

A standard file selection dialog box will prompt you to identify the file you wish to load the audio from. Only
AlarmBook supplied or created disc type files, AudioNotes, and 'sfil' types will appear in the file list. Once you
have chosen the file to load, click Load to proceed or Cancel to abort.

The  audio  samples  from the  disc  file  will  be  copied  to  your  resident  audio  area  and  can  then  be  used  in
conjunction with any date, periodic, or chime alarm.

To create a new disc file for audio storage, select the Create new disc file option in the Options menu. A
standard folder selection dialog box will prompt you to identify the name and destination folder of the new disc
file to create. Type in the name of the file, select it's destination folder, then click Save to proceed or Cancel
to abort. The new disc file will initially be empty.

To add resident audio to the new disc file, select the Save note/disc audio option within the Options menu.
A standard get file dialog box will prompt you to identify the file in which the resident audio is to be appended to.
Choose the appropriate file and click Append to proceed or Cancel to abort.
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In addition to audio and visual messages, date alarms and periodic alarms can be configured to perform a task at
alarm time. The two tasks available in AlarmBook are the ability to launch applications (System 7 or later) and the
ability to power off the Macintosh.

To use either of these two features, you must first set
up a date or periodic alarm as described in Chapters
4 and 5.

Once you have done this, you can select the task you
want performed at alarm time by choosing it within
the Tasks menu. 

              

If  you  choose  Launch,  a  standard  file  selection
dialog  box  will  prompt  you  to  identify  the  file  to
launch. Select the file and click Open to proceed or
Cancel to  abort.  The alarm is  now configured to
launch the file when the alarm goes off immediately
following any audio or visual display. Applications can
be launched on a daily basis, or at a particular time
and date if so desired.

Similarly, if you choose  Shutdown Power, the
alarm will be configured to shut down the Macintosh
immediately following any audio or visual display.
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The AudioNote is  a specialized application that allows you to play and record messages directly into it.  The
AudioNote application can be identified by its cassette-tape icon, and is located in the AlarmBook folder.

This application will hold an audio recording of up to 5 minutes depending on the amount of memory available,
and also depending on how much memory is allocated to the AudioNote application. To increase the memory size
of the AudioNote, you must first select the AudioNote icon by clicking once on it. Next, use the Command-I key
sequence or the  Get Info option in the standard apple file  menu to bring up the AudioNote's  information
window. Type in a larger Current Size  (System 6) and close the window. 

If you click twice on the AudioNote, it will play the current message or give you an error if none exists. The first
time you click on the originally supplied AudioNote, it will give you an error because it has no message to play.

To record into the AudioNote, hold down the Command key (the key with the apple symbol on it) while clicking on
the AudioNote icon. A configuration window will appear which has four controls. A Playback Volume scroll
bar, a Recording Limit scroll bar, a Recording Quality scroll bar, and a Click to Record activation
button.

Adjust the Playback Volume scroll bar to set the
audio's  playback  volume.  Adjust  the  Recording
Limit scroll  bar  to the maximum amount  of  time
you  wish  to  allocate  for  this  recording.  Adjust  the
Recording Quality scroll bar to select the type
of quality you want your recording to have. Once all
of these scroll bars are adjusted to your taste, click
on the Click to Record activation button.

You  should  now  see  the  standard  recording  dialog
box. Click Record to start recording. When you are
finished, click Save to continue. Once the recording
dialog disappears, exit the AudioNote application by
clicking  on  the  close  box  in  the  upper  left-hand
corner  on  the  main  window.  Your  new  message  is
now part  of  this  AudioNote and will  be played the
next  time  anyone  clicks  on  it  without  holding  the
command key down.

If you wish to make another AudioNote, just select the AudioNote and choose  Duplicate  using the standard
Macintosh file menu. The new AudioNote will contain the same message as the old AudioNote. To record a new
message into the duplicated AudioNote, use the process described above.
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You  can  duplicate  as  many  new  AudioNotes  as  your  disk  space  allows.  You  can  organize  and  store  many
AudioNotes to keep track of work related activities or daily events in your life. You can use it to keep a personal
log of past mistakes. You can send an AudioNote as a file to any person on your Macintosh network using one of
the popular e-mail packages that allow file transfers. When the destination user receives the AudioNote, it can be
listened to, stored, or deleted at their leisure.
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You must check Appletalk as active in the chooser before you restart your Macintosh in order for the AlarmBook
message service to work.

All legitimate AlarmBook users will appear as items in
the Message sub-menu.

To send a message, use the  Message sub-menu
located in the Send menu to select the destination
AlarmBook user.

 

A window will appear having the necessary controls
needed to select an audio and type your message.

If  you wish to send a visual  message, simply type
your  message in  the text  entry  box located in the
upper half of the window. If you choose not to send a
visual  message,  simply  leave  the  text  entry  box
empty.
To  choose  an  audio  to  send,  simply  select  it  by
clicking  on  the  name  of  the  audio  in  the  audio
selection box.

If you choose not to send an audio message, do not
select anything.

You  are  now  ready  to  send  your  audio/visual
message.  Simply  click  Send Now to  start  the
transmission. 

When  an  AlarmBook  user  receives  an  incoming
message, he/she is notified by the incoming message
alert  sound.  This  alert  sound  is  not  part  of  your
resident audio.

Next, a dialog box will appear with two options: I am
Busy and Get the message.

If you select  I am Busy, the message will be ignored and a corresponding message will be sent back to the
original sender notifying them that you are busy and can't respond to the incoming message.
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If  you  select  Get the message,  the  audio
message  will  played  and  the  visual  message
displayed.

To  select  a  pre-defined  response,  click  on  the
appropriate  response  button.   To  send  a  custom
response,  simply  start  typing  a response and click
Custom Response.
Your  response  message  will  immediately  be
transmitted back to the original sender.

To  turn  off  your  audio  and/or  visual  message
receiving  capabilities,  refer  to  the  instructions  in
Chapter 17, Preferences. 
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You must check Appletalk as active in the chooser before you restart your Macintosh in order for the AlarmBook
file transfer service to work.

All legitimate AlarmBook users will appear as items in
the File sub-menu.

To send a file, use the File sub-menu in the Send
menu to select the destination AlarmBook user.

Next, a standard file selection dialog box will appear.
Select the file you want to send and click SEND.

A  Waiting  for  Approval dialog  box  will  appear
while the destination user is asked for file acceptance
approval.  If  the user accepts your request,  the file
will  start  to  transfer.  You  can  monitor  the  file's
progression by viewing the file transmission bar. If no
error messages are shown, the file was transferred
properly.

On the receiver's machine, the file will be placed in the root directory of the Macintosh startup drive by default.  To
specify a custom directory you would like all incoming files to be placed in, use the Options menu to choose
Specify network folder.  A folder selection dialog box will allow you to choose your specific folder.  Changes to
designate the network folder will not take affect until after exiting the AlarmBook application.

For  information  on  how to  disable  the  approval  process  on  the  receiving  machine,  refer  to  Chapter 17,
Preferences.
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The Send sub-menus are constructed when the AlarmBook application is first executed. This is the only time the
network is scanned for potential AlarmBook users. Therefore, if you wish to get a fresh Send menu reflecting all
new users that may have powered on while in AlarmBook, select the Refresh users option in the  Options
menu.  This  will  force  AlarmBook  to  re-scan  the  network  for  any  new  AlarmBook  users.  Future  revisions  of
AlarmBook will include automatic sensing of new AlarmBook users.

If  you want to send a message or a file  to an AlarmBook user in another zone, simply select  the Change
Appletalk Zone option in the Options menu and choose the new zone.  AlarmBook will automatically scan
the new zone for  all  legitimate AlarmBook users.   The  Message and  File  sub-menus will  then reflect all
AlarmBook users found in the new zone.
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All preferences are accessible through the Preferences sub-menu located within the Edit menu.

To control the displaying of the clock in the menu bar, check or uncheck the  Preferences option Display
clock.

To bypass the initial AlarmBook title screen, uncheck the Preferences option Show title screen.

To cancel all active alarms at any time outside of the AlarmBook application, press the  Command and ESC
keys simultaneously. 

To abort the loading of the AlarmBook Init while restarting your Macintosh, hold the Command and ESC keys
simultaneously down when restarting until you see the AlarmBook abort dialog box.

To abort a chime alarm in progress, hold the ESC key down until the audio stops.
To  deny  network  audio  transmissions,  uncheck  the  Preferences option Accept  audio  messages.
Unchecking  this  preference  will  enable  you  to  save  transfer  time  when  other  users  try  to  send  you  audio
messages.

To deny network visual messages, uncheck the Preferences option Accept visual messages.
To  turn  off  the  alert  sound  played  when  an  incoming  network  transmission  is  recognized,  uncheck  the
Preference option Sound when receiving from network.

To disable the incoming file transfer approval dialog, uncheck the Preference Automatically accept all file
transfers.

To abort a file transfer in progress, press the ESC key.
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This copy of AlarmBook™ must be on the hard disk it was installed on

Cause: AlarmBook is being executed from a hard disk that it was not originally installed on.
Solution: Reinstall the software from the original distribution disk.

Error: AlarmBook Init not loaded
Error: AlarmBook can't find the AlarmBook Init file
Cannot Open Driver - AlarmBook Init not loaded

Cause: The AlarmBook™ Init file was not properly loaded.
Solution: Reinstall the software and check for a possible init conflict between AlarmBook™ Init

and another init.

AlarmBook needs at least System 6.0.7 or later to execute.

Cause: The version of your system software is below 6.0.7.
Solution: Upgrade your system to at least 6.0.7.

Error: Not enough memory to play this audio. Increase application memory size and try again

Cause: Could not allocate enough memory to record the sound.
Solution: Try to increase the current size of the application by using Command-I

after selecting the file AlarmBook. Type in a higher Current Size in
the application's information window and re-run the application. If
this still does not work, decrease the requested recording time limit or change
the sound compression to a higher compression like 6:1.

Error --> Resource Error -108 Calling " " resource
Error: Not enough memory to send audio requested

Cause: Could not allocate enough memory to manipulate audio files.
Solution: Try to increase the current size of the application by using Command-I

after selecting the file AlarmBook. Type in a higher Current Size in
the application's information window and restart the application.

Error --> Sound Record Error #

Cause: Sound Manager error.
Solution: Verify that a input device was selected using the sound control panel.

Error --> Resource Error # Calling "          "
Error: Resource Error trying to load audio
Error: Can't find audio to send
Error: Adding ALMS resource to AlarmBook Init
Error: Writing ALMS resource to AlarmBook Init
AlarmBook can't find needed resource '    ' in AlarmBook™ Init
Error: AlarmBook can't find 'ALMS' resource

Cause: Corrupted external file or corrupted AlarmBook™ Init. 
Solution: Reinstall the software or recreate your AlarmBook disc or collection files.
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Sorry. A maximum of 30 alarms is allowed

Cause: You are trying to exceed the maximum number of 30 alarms by creating a new alarm.

Solution: Delete an old alarm or save the entire alarm collection and start a new alarm collection.

AudioNote has no message to play

Cause: The AudioNote has been recently installed and has no message to play; or,
the AudioNote is corrupted and missing valuable resources.

Solution: Check to make sure the name is AlarmBook™ Init and the file is located in 
your Extensions Folder for System 7.0 or above, or in the System
Folder for System 6.0.7. Reinstall the software package if this error 
message fails to disappear.

Error: Can't find bridge. No internet
Error: OSerr occurred while locating zones
Error: No memory for NBP lookup buffer
Error: NBPLookup failed
Error: Extract Failed in make net menu
All zone search OsErr
Error: Extract failed in sendData
Can't allocate 512L block for transfer

Cause: Appletalk network error has occurred.
Solution: Make sure your version of Appletalk is current and active.

"xxxxxx" is not responding
Just received a transmission of wrong size
OsErr on PGetRequest after transmission error
Error: AlarmBook network error
Severe Network Error: Please restart this Macintosh
Network Error: Cannot find sender
AlarmBook Error: Time limit exceeded waiting for data
AlarmBook Error: Network transmission failed

Cause: Network transmission problem.
Solution: Check your network connection. Check to see if the network is down. Use the refresh network option in

AlarmBook in the event that the destination AlarmBook user shut 
their machine off.
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Error in loading or opening AlarmBook Driver
Error in loading driver tables
Error in loading owned resource tables
Error in loading driver table
Error in flagging driver table as changed
Error in loading owned resource table
Error in flagging owned resource table as changed
Error - Cannot load driver to verify heap space
System heap not big enough to load drivers
Cannot Open Driver - AlarmBook Init not loaded
Cannot Open Driver - AlarmBook Init not loaded
Cannot load driver because memory is too low
Error # occurred opening the AlarmBook™ driver

Cause: Corrupted AlarmBook™ Init. 
Solution: Reinstall the software from the original distribution disk.

AlarmBook has detected another user who has the same network name as you.   Please reinstall
AlarmBook™ and register using a different name

Cause: Entity name conflict error. 
Solution: Reinstall the software from the original distribution disk and choose a different user name when 

registering.

Error: Can't play sound due to channel error
Error: Alarm could not be played because of a sound channel problem

Cause: All available sound channels have been taken.
Solution: Terminate any software application that is producing sound and/or consuming sound channels.

Alarm could not be played because lack of memory

Cause: Not enough memory is available to play the alarm's audio.
Solution: Remove any memory consuming inits that may have taken AlarmBook's memory and restart your system.
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NEPTUNE SYSTEMS LICENSE AND LIMITED WARRANTY AGREEMENT

USE OF ANY PORTION OF THIS SOFTWARE PACKAGE INDICATES YOUR AGREEMENT TO THE FOLLOWING TERMS
AND CONDITIONS. IF YOU DO NOT AGREE WITH SUCH TERMS AND CONDITIONS, YOU SHOULD PROMPTLY RETURN
THIS PACKAGE BEFORE USING IT TO YOUR PLACE OF PURCHASE FOR A REFUND.

PERMITTED USES
Neptune Systems grants you a non-exclusive license to use the software in this package
according to the terms set forth below. 

You may:

• Install and operate this software on a maximum of one computer at a time.
• Make one backup copy of the originally supplied floppy disk(s) which automatically becomes the

property of Neptune Systems and is subject to this agreement.

PROHIBITED USES
You may not:

• Make the software available to any person or entity other than yourself.
• Modify the software or merge it with another program. Any modified or merged portion of

this software is subject to this agreement.
• Reverse-engineer, disassemble, decompile, or make any attempt to discover the source code

to the software.
• Translate or create derivative works based on the software.
• Remove, obscure, or alter any notice of the Neptune Systems copyright or other proprietary

rights related to the software.
• Sub-license, sell, lend, rent, or lease any portion of the software.
• Copy any portion of the software, except to make a backup copy.
• Transfer the software or any direct product to any person or entity in violation of the

United States Export Administration Act.

The software involves valuable proprietary rights of Neptune Systems. Neptune Systems retains
title and ownership of the software and all copyright, trade secret, trade name, trademark, and
other property rights related to the software, regardless of the form that the original or other
copies exist in. You may not violate these rights, and you must take appropriate steps to protect
Neptune Systems' rights. Neptune Systems may at any time replace, modify, alter, improve,
enhance, or change the software.

Both the license and your right to use the software terminate automatically if you violate any part 
of this agreement. In the event of termination, you must immediately destroy all copies of the 
software or return them to Neptune Systems.
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LIMITED WARRANTY
Neptune Systems warrants that, upon delivery by Neptune Systems, the disks on which the
software program is distributed will be free from defects in material and workmanship and that
the software will substantially conform to the specifications established by Neptune Systems. 
Neptune Systems does not warrant that the software is free from all bugs, errors, and omissions.

If any of the software fails to comply with the warranties set forth above, Neptune Systems will 
replace the disk(s) or, at Neptune System's option, make a reasonable effort to correct the
program errors. You must, however, return all copies of the software, along with a copy of your
dated and paid invoice, to your place of purchase within 90 days of the date you received the
software. If Neptune Systems is unable to correct defective disks or program errors, Neptune
Systems will refund all or a fair portion of the price you paid for this package. The refund will
fully satisfy your claims for software or disk failure. This limited warranty shall continue for
any replacement software for the rest of the original 90 day warranty period or for 30 days from
the date you receive the replacement, whichever is longer.

Except as specifically set forth above, Neptune Systems disclaims all other warranties, either
express or implied, including but not limited to implied warranties of merchantability or fitness
for a particular purpose. This limited warranty gives you specific legal rights, and you may also
have other rights, which vary from state to state.

Except as specifically set forth above, Neptune Systems and its distributors and dealers will in
no event be liable for any damages whatsoever for consequential or incidental damages, either
direct or indirect, including but not limited to loss of business profit, income or use of data. Some 
states do not allow exclusion or limitation of incidental of consequential damages; therefore, the 
limitations set forth in this agreement may not apply to you.

Though Neptune Systems is not responsible for maintaining or helping you use the software,
Neptune Systems does offer a telephone support program. To receive these full benefits, you must 
complete and return the enclosed User Registration Card.

This agreement constitutes the entire agreement and supersedes any prior agreement between
Neptune Systems and you concerning the contents of this package. Neptune Systems is not bound
by any provision of any purchase order, receipt, acceptance, confirmation, correspondence, or
otherwise, unless Neptune Systems specifically agrees to the provision in writing. Any
distributors, agents, or employees will in no way increase the scope of this warranty. Nor may
you rely on any such oral or written communication. This agreement cannot be amended, modified
or waived, unless the change is written and signed by an authorized corporate officer of Neptune
Systems. This agreement is bound by the state laws of Texas concerning software media.
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Neptune Systems
12803 Rampart

Austin, Texas 78727
(512) 837-1247
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